FB12 Single Tube Luminometer

User’s Manual

FB12-e-07/06 _I B e rt h O I d

© Berthold Detection Systems GmbH, 2006 1 DETECTION SYSTEMS







FB12 Luminometer Contents

Contents

| Safety Instructions 1|

H.  Getting Started 3
R, Structure of Microprocessor SOftWare ........csssesssssssassssassssasessd)

.1 Overview 7|
B.2 Raw Data Measurement 9l
B.3 Check Mode 10|
U1 PC Software Installation 11]
4.2 |nitial Software Start Up 12|
4.3 Basic Software Structure 15|

4.31 Protocol Manager. oo iveeniiiieiiiiiiiiiiiiici 16|

4 3 2 Measurement Menu 17

k33 Warking with the Software 18
k4 FB12 L uminometer Setup 19
hs Comparison of Software Protocols 21|
|5 Quick Measurement 22|
|5 1 Protocol 22|
h 2 Measurements 22|
ki. Single Assay 23J
b 1 Protocol 23|
b 2 Measurements 25|
Iz Dual Assay 26|
.1 Protocol 26|
7.2 Measurements 28|
B. _ Single Kinetics 29|
8.1 Protocol 29
8.2 Measurements 31
9.1 Protocol 32|
9.2 Measurements 33|
110.1 Protocol 35|
[10.2 Measurements 37|

| Berthold

L1 DETECTION SYSTEMS




Contents

FB12 Luminometer

i Exiernal Pricter with Additonal Onf m

111 Physical Installation of the Printer 38/
1.2 Printer Setup 39|
11.3 Cut-Off Protacal 39|
11.4 Cut-off Measurement 41|
11.5 Extended Raw Data Protocoal 42|
11.6 Raw Data Measurement 43|
H2. Maintenance 44|

h3. TechnicalData «oooeoooooooooeooeooeoooeoeooo 45|
H4. Preparing FB12 for Transport 47|
T e
he. D tamination E |

Typographical Conventions

FB12 Luminometer

Messages on the LC display are printed in boldface type,

e.g. menu MEASURE, SCROLL or MAIN.

The <ENTER> function key is printed in boldface inside pointed
brackets.

PC software

Menu and option titles of the PC software are printed in boldface
inside square brackets ([ ]),
e.g., [File], [Options].

PC software buttons are printed in boldface inside pointed brack-
ets (<>),
e.g., <OK>, <Start Quick Measurement>, <F1>, <enter>, <Alt>.
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FB12 Luminometer Safety Instructions

Safety Instructions

The FB12 luminometer was manufactured in accordance with
safety requirements for electronic and medical luminometers. It is
the operator's responsibility to adhere to regulations on the instal-
lation and/or operation of sample measuring systems that are re-
quired by law. The user must assure that assays for in-vitro-
diagnostic use are validated with the system.

The manufacturer guarantees safe operation of the equipment,
both electrically and mechanically, if user follows the instructions
set forth in this manual. The user must ensure that the instru-
ments are set up and installed in such a way that their function is
not impaired.

The instruments have been tested by the manufacturer and are
supplied in a condition that allows safe and reliable operation.

This User’'s Manual includes information and warnings that have
to be observed by the user to ensure safe operation of the in-
struments.

Please adhere to the following safety instructions before tak-
ing the instrument into service and during operation of the
system:

1. Only trained personnel may operate the instrument. It is
strongly recommended that all users read this manual prior to
use.

2. The instrument may only be used for the designated applica-
tion. A single sample luminometer is employed for detection
of chemi- and bioluminescence in different sample tube for-
mats.

3. Berthold Detection Systems assumes no liability for any
damages, including those to third parties, caused by improper
use or handling of the device.

4. The system is designed according to the IEC 1010-1 or
EN 610 10-1 regulations for electrical measuring systems.

5. Only qualified personnel may carry out Service and repair
work . Reassemble it completely before use.

[ 1Berthold
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Safety Instructions FB12 Luminometer

6. The user may only perform the maintenance work described
in this manual.

7. Use only parts described in this manual for servicing.

8. The instruments are live and improper handling may cause
damage.

9. If you realize that the instrument has become unsafe to use,
switch it off and disconnect it from the power supply.

10. All instruments supplied and all additional devices must be
grounded. Use three-prong, grounded plugs.

11. Before opening the locking screw or the instrument head on
the top side of the instrument, disconnect power and then
open the sample drawer to protect the photomultiplier against
direct incident light. Otherwise, the photomultiplier may get
damaged!

Do not keep the sample drawer open for a long period of
time.

12. If liquid gets inside the instrument, pull the power cord. Clean
the unit or have it cleaned by an authorized service center .

The tests and maintenance work recommended by the manufac-
turer should be performed to make sure that the operator remains
safe and that the instrument continues to function correctly. Au-
thorized service engineers must perform any service and mainte-
nance work not described in the operating manual.

Return shipment If the instrument has to be returned to Berthold Detection Sys-

tems for servicing or inspection, we recommend that you use the
A original cardboard box.

Please remove the reflector (sample holder) in order to avoid
damage to the sample chamber (see chapter 14).

Disposal

This luminometer contains electronic parts. To prevent environ-

mental pollution please dispose the instrument and the corre-

sponding accessories according to the directive 2002/96/EC or
I contact your local representative.

1 Berthold

2 L1 DETECTION SYSTEMS




FB12 Luminometer 1. Getting Started

1. Getting Started

Description

The FB12 luminometer is a highly sensitive and compact single
sample luminometer, designed specifically for the detection of
chemiluminescence and bioluminescence in different kinds of ap-
plications. It can be employed for all glow type measurements.
The sample chamber accommodates various sample formats.
FB12 may be operated as a standalone instrument using special
Windows software..

Optionally, an external printer can be connected to the FB12. In
this case, additional cut-off measurements can be run on the
standalone instrument and the results can be output to printer
(see chapter 11).

Luminometer installation

QO The instrument should be set up in a dry, dust-free environ-
ment and protected from direct sunlight and significant tem-
perature fluctuations!

Q Carefully unpack the FB12 Luminometer and put it on your
desktop.

O Plug the connector module that fits into your wall outlet onto
the power supply unit.

Q Plug the power supply unit into a wall outlet and the pin con-
nector of the power supply unit into the socket on the instru-
ment rear panel.

O Turn the instrument on at the mains switch. The display will
show: ,Please wait“ while the instrument is performing a self-
test. Then the main menu appears.

O Open the sample drawer and insert the sample holder (reflec-
tor).

Il i O Different sample formats may be used:
&/ v/ Ja J Culture dishes with up to 35 mm diameter
X" / Scintillation bottles containing up to 20 ml
Reaction bottles with up to 12 mm diameter and up to 75 mm
length (see chapter 13).

- 1Berthold
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1. Getting Started

Figure 1:
FB12 Lumi-
nometer
(rear view)

FB12 Luminometer

ON/OFF
switch

N

RS232
port
uUSB
port

Socket

Configuration

Set up the instrument parameters according to your needs as fol-
lows (confirm entries with <Enter>, push <Next> to continue with

next display):
FB12 LUMINOMETER
MEASURE MEAS.SET. NEXT
[
PC-OPER SYSTEM MAIN
\2
SYSTEM
CONFIG CHECK NEXT
\2
USE RS232 FOR PC/PRINTER:
SCROLL MAIN NEXT

O Select PC if the FB12 is used as standalone instrument for
raw data measurements or if the luminometer is connected to

a PC.

Q If you are using the FB12 as standalone instrument to run cut-
off measurements or you want to print out raw data, then con-
nect an external printer and select PRINTER (see chapter 11).

U Then select the desired language and enter Date and Time,

Baudrate (9600) and the RLU factor = 1.

1 Berthold
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FB12 Luminometer 2. Structure of Microprocessor Software

2. Structure of Microprocessor Software

Operating elements on the front panel

Figure 2: [ 1Berthold
Operatlng elements L1 DETECTION SYSTEMS
on front panel FB12 LUMINOMETER V3.0

MEASURE MEAS.SET NEXT.

WA

‘ FB12 LUMINOMETER
I

Main menu softkeys function key<enter>

Meaning and operation of individual functions

MEASURE Measurement in stand-alone mode after input of measurement
parameters and configuration.

MEAS.SET. Define the measurement parameters for stand-alone operation.

If the interface is set to PRINTER, you may choose parameter en-
try either for a raw data or for a cut-off measurement (see chapter
11).

PC-OPER Switchover to PC-OPERATION. This function is not available if
the interface has been set to PRINTER.
SYSTEM CONFIG: Define the system parameters.

CHECK: Here a continuous measurement is performed (see
chapter 3.3).

Accept Confirm each entry or new setting with <ENTER>. If you want to
keep a setting, you may proceed directly with NEXT or MAIN.
Input CURSOR Move the cursor left.

SCROLL The highlighted digit or letter is incremented by 1
(cyclical order: 0,1...9,0,1...and A,B ...Z, A ..).

[ 1Berthold
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2. Structure of Microprocessor Software FB12 Luminometer

Menu Structure of the Instrument Software

e | I
v

PROTOCOL: RD / CUT-OFF
PC-OPERATION 30 RLU/s

SCROLL MAIN  NEXT DOOR OPEN enp || | sysTem
CONFIG CHECK

PC-OPERATION 30 RLU/s

DOOR CLOSED END USE RS232 FOR: PC/PRINTER

MEASURE 30 RLU/s ARE YOU SURE?

D=0.0s T=10.0s MAIN RN : YES NO
CROLL CURSOR NEXT

CUT-OFF MEASUREMENT

Serial port set to printer and Cut-off
protocol selected

[

READY
D=2.0s T=10.0s MAIN

Serial port set to printer

INSERT NEGREPL1
CLOSE DOOR MAIN

NEXT

CUT-OFF

MEASURE 30 RLU/s|
NEGREPL 1 D= 2.0s T= 10.0s|

MEASURE 30 RLU/s
D=20s T=100s MAINP™ : | OPERATOR: ... OPERATOR: ...oovoocirrirrr
SCROLL CURSOR NEXT

MEASURE 4500 RLU/s|
NEGREPL1D=0.0s T=6,5s

LANGUAGE: ENGLISH

DATE: 01.08.2003 09:37
SCROLL CURSOR NEXT

ENTER PASSWORD: XXXX
SCROLL CURSOR NEXT

DONE 4500 RLU/s
REMOVE NEGREPL1 MAIN

MEASURE 4520 RLU/s
D=0.0s T=6.5s MAIN

CUT-OFF-FACTOR: X.XXX
SCROLL CURSOR

DELAY TIME: 20s
SCROLL CURSOR NEXT

DONE 4500 RLU/s
REMOVE SAMPLE ~ MAIN

INSERT NEGREPL2
CLOSE DOOR MAIN

NEG.STAND.REPL : 2

SCROLL MAIN NEXT BAUDRATE: 9600

SCROLL  MAIN NEXT

MEASURING TIME: 10.0s
SCROLL CURSOR MAIN

MEASURE 30 RLU/s
NEGREPL2 D=2,0s T=10,0

SAMPLE REPL:
SCROLL MAIN

1
NEXT

RLU-FAKTOR: 1.000
SCROLL CURSOR MAIN

MEASURE 4500 RLU/s
NEGREPL2 D=0,0s T=6,5s

DELAY TIME: 20s
SCROLL CURSOR NEXT

DONE 4500 RLU/s
REMOVE NEGREPL2 MAIN

A

MEASURING TIME: 10.0 s
SCROLL CURSOR MAIN

. T v

MEAS.TIME: 10.0s
SCROLL CURSOR NEXT

INSERT SAMPLE 1 REPL1
CLOSE DOOR MAIN

MEASURE 22 RLU/s
T=10.s MAIN

MEASURE 30 RLU/s
S1R1 D=2.0s T=10.0s

DONE 4500 RLU/s
REMOVE S1R1 MAIN »

1 Berthold
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FB12 Luminometer 3. Measurement in Stand-alone Mode

3. Measurement in Stand-alone Mode

3.1 Overview

The luminometer should be switched on at least 30 minutes be-
fore starting a measurement.

Units

Luminescence is measured in ,Relative Light Units“ (RLU). The
RLU/s displayed by the FB12 luminometer are equal to the
counts/s picked up by the detector, with the default RLU factor set
to 1.

RLU/s = cps ¢ RLU factor

The factory-set factor (=1) should be changed only when compar-
ing results measured with different luminometers. The entered
factor multiplies all measured results; it is changed on the main
menu under SYSTEM.

Overload

If one or several measured values in the measurement interval
exceed the measuring range of the luminometer, OVERLOAD
appears on the display. To obtain a meaningful result, the sample
has to be diluted and measured again.

DONE OVERLOAD RLU/s
REMOVE SAMPLE MAIN

Definition of measurement and delay time

Figure 3:
lllustration of ’i |
delay and meas-
urement times delay time measurement time
>
™~ Close sample drawer Time axis (seconds)

All delay times start with the closing of the sample drawer. The
minimum delay time is 1 s.

[ 1Berthold
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3. Measurement in Stand-alone Mode FB12 Luminometer

Discarding and repeating a measurement

Opening the sample drawer will terminate a measurement.

In the raw data mode the display shows:

MEAS. ABORTED!
PRESS ENTER!

Close the sample drawer and push <ENTER> to start the next
measurement.

In case of a cut-off measurement (only possible if the interface
has been set to PRINTER), the following display appears:

MEAS. ABORTED!
REPEAT DISCARD

REPEAT Repeat measurement of replicate sample.
DISCARD Measure next sample.

The measured values are calculated depending on this selection.

Data output on display
Only raw data in RLU/s are displayed.

1 Berthold
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FB12 Luminometer 3. Measurement in Stand-alone Mode

3.2 Raw Data Measurement

In the raw data mode, samples are measured and numbered con-
secutively.

Creating a protocol"

FB12 LUMINOMETER

MEASURE MEAS.SET NEXT
N4

DELAY TIME: 2.0 s

SCROLL CURSOR NEXT

MEASURING TIME: 10.0 s

SCROLL CURSOR MAIN

O Define delay time and measurement time.

U Press MAIN to return to the main menu.

Raw Data Measurement

O The display shows the main menu:

FB12 LUMINOMETER
MEASURE MEAS . SET NEXT
02
READY 30 RLU/s
D= 2.0s T= 10.0s MAIN

Q Insert sample tube and close sample drawer. The measure-

ment starts.
MEASURE 4500 RLU/s
D= 2.0s T= 10.0s MAIN

O At the end of the measurement time the following display ap-

pears:
DONE 4500 RLU/s
REMOVE SAMPLE MAIN

R If the interface has been set to PRINTER, you can here choose between raw
data and cut-off (see chapter 11).

- 1Berthold
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3. Measurement in Stand-alone Mode FB12 Luminometer

3.3 Check Mode

The check function enables the user to check the photomultiplier
if no measurement is running. The measured RLU values are dis-
played continuously regardless of whether the sample drawer is
open or closed. Push MAIN to terminate the measurement.

PC-OPER SYSTEM MAIN

U Push the SYSTEM button to open the PARAMETER menu.

SYSTEM
CONFIG CHECK NEXT

1 Push the CHECK button. The selected measurement time is
used as integration time.

MEAS. TIME 10.0s
SCROLL CURSOR NEXT

U Change the measurement time with SCROLL and confirm
with <ENTER>. Push NEXT to start the measurement.

MEASURE 22 RLU/s
T = 10.0s MAIN

U Push MAIN to return to the main menu.

1 Berthold
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FB12 Luminometer

4. Working with the FB12 PC Software

4. Working with the FB12 PC Software

4.1

Q
Q

O 000D

PC Software Installation

Close all Windows applications.

Insert software CD in the CD drive. The CD navigator will
automatically start the internet browser.

Select “Software” in the navigator bar, then “FB12/Sirius
Software Installation”.

Double-click the Setup.exe file to initiate the setup.

If the CD navigator does not automatically start, open Win-
dows Explorer and select CD drive. Double-click start.htm to
start the CD and continue, as described above, to install the
software.

Follow the instructions of the setup program. When the pro-
gram is started, the [Welcome] screen is displayed. Click
<Next>. The [Choose Destination Location] dialog box ap-
pears. Click <Next> to keep the defaulted directory
C:\...\FB12 software. Click <Browse> to choose another di-
rectory. Select the base software and the different protocol
types in the [Select Components] dialog box.

Click <Next>: [Select Program Manager Group].

Click <Next> (display of [Start Installation]).

Click <Next> to start the installation.

Upon completion of the installation process, click <Finish>.

The software includes a 30 days trial option for non-purchased
software components.

Important information for Windows NT/2000 users

Please ensure the software is installed in administrator mode. For
work with the software administrator rights are not necessary.

[ 1Berthold
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4. Working with the FB12 PC Software FB12 Luminometer

Installation of additional protocol types

Proceed as described above. Select the protocol types needed in
the [Software Components] dialog box. Then complete the in-
stallation.

Instructions for use of USB connection

After installation of the FB12/ Sirius software, connect the lumi-
nometer to PC using the USB.

U The PC will recognize that there is a new device and ask for a
driver. Follow the installation wizard and install the respective
driver from your CD.

U Note the communication settings in Windows System [Hard-
ware],[Device Manager]. The USB Serial port is usually as-
signed as COM3 or higher. Notice the assigned COM port for
selection in the [Serial port] box of the FB12/ Sirius software
(see 4.2).

4.2 Initial Software Start Up

U Double-click on the FB12 software ICON.
U Click on the <Options> button.

U Select the serial port used (COM1 or COM16) in the [Serial
Port] box. For use of the USB connection select the COM port
assigned to the USB Serial port (see 4.1). COM1 or COM2 are
generally used for RS232 connection. Set the baud rate to
[9600].

O In the [Default Data storage directory] box, enter the directory
where the measurement data are to be saved.

U To hear a signal at the end of a measurement, select the item
[Beep when measurement is completed].

O Click <OK> to save the entries. The program changes to the
Protocol Manager.

1 Berthold
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FB12 Luminometer

Figure4-1:
[Registration
Form] dialog box

—

4. Working with the FB12 PC Software

Software Registration

FB12/ Sirius software may be used for 30 days without registra-
tion. A prompt to enter a registration password will appear each
time a protocol is selected or the measurement menu is opened
until registration passwords are entered. User may close the Reg-
istration Form dialog box by clicking <Run Now, Register
Later> and continue working with the software.

The passwords must be entered within 30 days in order to con-
tinue working with the software. The [Registration Form] dialog
box appears again; either enter registration password or click
<Cancel> to close this dialog box.

Passwords may be requested via E-Mail, Fax or Web. Follow the
instructions on the registration form. Press the respective E-mail,
Web or Fax button, insert required information in the predefined
mail, fax form or web registration form and forward to

Berthold Detection Systems.

Registration Form EJ

Single Assay For FB12/Sirius Software

Copyright [c] 2005 Berthold Detection Systems GmbH, All Rights Reserved.

Thig unregistered version of the Single Assay will run for 30 daps after first run.
Flease register before that time to enable unlimited uze.

Drays left: Trial Period Expired! I:l

System D: FBS-135653

To obtain the password to enable the software, please contact Berthold Detection Systems.
Press the e-mail, the web or the fax button to get the contact formular and insert all required
infarmation:

Or vigit http: / Awvae. berthold-ds.com/register/al. php

E-mail wieh Fan

Fleaze enter your registration information here:

Mame: |

Company: |

Password: |

Reqister Mow | Cancel |

Passwords may also be requested via the BDS homepage.
Please provide the System ID of the PC. The number is printed in
red in the registration dialog of the software.

- 1Berthold
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4. Working with the FB12 PC Software FB12 Luminometer

Registration

Owner will receive registration passwords from Berthold Detection
Systems (one password for each purchased protocol).

When [Registration Form] dialog box appears, enter the user's name,
the company name and the password for that protocol. Click <Reg-
ister Now>. Upon entry of correct passwords, the software may con-
tinue to be used. The [Registration Form] dialog box will not appear
again.

1 Berthold
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FB12 Luminometer

4. Working with the FB12 PC Software

4.3 Basic Software Structure

protocol manager

Figure 4:
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4. Working with the FB12 PC Software FB12 Luminometer

4.3.1 Protocol Manager

[Protocol types]
Shows the protocol types which can be used as templates for cre-
ating protocols.

[Runable protocols]
Shows a list of created protocols. Protocols are edited using the
buttons in this box:

<Run>
Shows the measurement menu and you can start a meas-
urement with the selected protocol.

<Edit>
Edit the parameters in the selected protocol.

<Delete>
Delete the selected protocol.

Quick Measurement
is not a protocol type, but a measurement protocol; parameters
may be changed, but may not be stored in separate protocols.

<Retrieve>
Shows the stored measurement data; double-click to open the
desired data file (*.MDS).

<Options>

Gives information about the used COM port, the Baud rate and
the default data storage directory.

1 Berthold
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FB12 Luminometer 4. Working with the FB12 PC Software

4.3.2 Measurement Menu

Select the desired protocol and click <Run>. The measurement
menu is displayed.

Before starting a run
On the luminometer: Select NEXT and then PC-OPER (see chap-
ter 4.4).

Measurement start
By opening / closing the sample drawer or pressing the green but-
ton or the spacebar.

Meas. completed
As soon as the measurement time is over.

Measurement stop
By opening the sample drawer or pressing the red button.

Single values

Measured results are transferred from the luminometer to the PC
every 0.2 seconds. To view single values, place the cursor over a
measured result.

Result fields

To change the size of a result field, move cursor to the right-hand
margin of the header. As soon as the cursor shape changes to a
double-arrow, click the left mouse button and drag the cursor,
with the mouse button held down, left or right.

EXCEL Transfer
— Click the button depicted to the left to manually import data into a
‘ = ‘ new or predefined Excel worksheet. The transfer may also be
automated in the protocol.

[ 1Berthold
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4. Working with the FB12 PC Software

FB12 Luminometer

4.3.3 Working with the Software

Tool buttons on the measurement menu simplify program han-
dling. Apart from a few exceptions you need not select any pull-

down menus.

Tool buttons and their meaning:

Button = Meaning

Save measurement
data

Import measurement
data into Excel

Print

Start measurement

Stop measurement

Delete last meas-
urement

Display results in
spreadsheet

Display results in a
graph

Tile window horizon-
tally

Tile window vertically
Create new data file

in measurement
menu

OB OE #3: RelE | X o

Copy selected data to
clipboard

i

Pull-down menu -> Option

[File] -> [Save (as)]
[Edit] ->[Send to Excel]

[File] -> [Print]
[Measure] -> [Start Measurement]
[Measure] -> [Stop Measurement]

[Measure] -> [Delete Last Measure-
ment]

[Measure] -> [Kinetics]

[Measure] -> [Kinetics]

[Window] -> [Tile Horizontal]

[Window] -> [Tile Vertical]

1 Berthold
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FB12 Luminometer

4. Working with the FB12 PC Software

4.4 FB12 Luminometer Setup

O Connect the FB12 luminometer with the respective cable (sup-

plied) to a serial COM port or USB port on your PC.

O Select NEXT and PC-OPER on the main menu to set the
FB12 luminometer to PC operation.
FB12 Luminometer
Measure MEAS.SET NEXT
FB12 Luminometer
PC Oper SYSTEM MAIN
PC-OPERATION 30 RLU/s
DOOR OPEN END

U The measuring instrument is now in the PC operation mode.
The measured values are displayed continuously in the top
row. The bottom row shows the status of the sample drawer.
Push END to return to the standalone mode.

Note!

The function PC operation is not available if the serial interface
has been set to PRINTER. To configure the interface for PC op-
eration, set the RS232 interface configuration on the SYSTEM
menu to PC communication.

[ 1Berthold

SYSTEM NEXT
SYSTEM
CONFIG CHECK NEXT
RS232 FUER PC/PRINTER
SCROLL MAIN NEXT
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4. Working with the FB12 PC Software FB12 Luminometer

U0 Push SCROLL and change the instrument from PRINTER
configuration to PC configuration.

U Push <ENTER> to confirm your entry. Push MAIN to return to
the main menu.

O On the main menu, select NEXT and then PC-OPER which is
now available.

1 Berthold
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FB12 Luminometer

4.5

Comparison of Software Protocols

4. Working with the FB12 PC Software

To help you get a quick overview of the different protocol types, we
have summarized their functions in the table below:

Quick Single Single Multiple Dual Cut-Off-
Measur. | Assay Kinetics Kinetics Assay Assay
Function Measurement of | Continuous Several samples, | Measurement of | Classification of
several samples | measurement of discontinuous sample series A | samples
with replicates one sample measurement and B
15t sample =BG |no yes no no yes Yes
BG may be BG may be
defined defined
Replicates no flexible yes yes same number yes: for
for Aand B samples,
neg. and pos.
controls
Number of any flexible 1 sample any, with any data | same number yes: for
samples measured with points for Aand B samples,
any data points neg. and pos.
controls
Calculations none >1 replicate: >1 replicate: >1 replicate: >1 replicate: >1 replicate:
average value average value average value average value average value
Y%stdv/av Y%stdv/av Y%stdv/av Y%stdv/av Y%stdv/av
repl. 1, repl. 2 repl. 1, repl. 2
log/normal log/normal
scaling, scaling,
smoothing, smoothing,
peak half-life time | peak half-life time
during increase during increase
and decay and decay
Kinetics graph none always for last | complete graph of | complete graph of | always for last | always for last
sample all replicates all replicates sample sample
Miscellaneous Meas. predefined measurement predefined predefined
sequence [ sample names start only at sample names | sample names
glosmg of sample different different cut-off
rawer ; :
calculation calculations and

formulas for A
and B

classifications
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5. Quick Measurement FB12 Luminometer

5. Quick Measurement

This protocol type measures the raw data of consecutively num-
bered samples.

5.1 Protocol

U In the Protocol Manager, select the [Quick Measurement]
protocol and click <Edit>. The [Quick Measurement Parame-
ters] dialog box appears.

0 Set Delay time for the measurement and Measurement time
by clicking on the respective arrow buttons.

U Click <Save> to save the measurement parameters. The pro-
gram returns to the Protocol Manager.

5.2 Measurements

U In the Protocol Manager, select the [Quick Measurement]
protocol and click <Run>. The measurement menu appears
showing the parameters Measurement time and Delay time
defined for the measurement.

U Open sample drawer and insert sample tube.

U Close sample drawer. The measurement process starts as
soon as the preset delay time is over.

O The result is displayed at the end of the measurement.

U Proceed in the same manner to measure the next sample.
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6. Single Assay

6. Single Assay

Figure 6-1:
Dialog box
[Single Assay
Parameters]
Page 1

This protocol type allows you to run background measurements
and to measure replicates of samples.

6.1 Protocol

Select Single Assay and push <Create>.

. Single Assay Parameters - Single Assay

beazure and delay times
Dielay time: Meazurement time:

l'llhi:l 1.0z :I Save fz.. |
=

Start meazurement by C |
ance

" Start button ar space bar + Door close
ar enter key

Murnber of replicates and zamples

Mumber of replicates: Mumber of samples:
— —
[ First zample iz background
Cornments:
I
Advanced Options... Ewcel [Th] Options...
[Delay time]

Delay before measurement; can be set only if a measurement is
started by closing the sample drawer.

[Measurement time]
Measurement time for each sample measurement.

[Start Meas. by]
Select how to start the measurement on the measurement menu:

[Start button]

- 1Berthold
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6. Single Assay FB12 Luminometer

By clicking the Start button or pressing the spacebar. No de-
lay time can be defined here!

[Door close]
By closing the sample drawer of the luminometer.

[Number of replicates]
[Number of samples]

[First sample is background] Measurements of the first sample
replicate are considered background measurements.

<Advanced Options>
Opens page 2 of the Single Assay Parameters dialog box.

~ Figure 6-2:  |Grid Options]
Dialog box [Single You may select a flexible table set-up, so that the number of rep-
Assay Parame- )
ters) licates and/or samples may be changed during measurement at

Page 2 the push of a button.

[Measurement orders]
Order of measurement

[Across]
Sample [Rep1 [Rep2 Measurements are carried out by rows: first, all replicates of
1 the first sample, then all those of the second sample, etc.
2
3
[Down]

Sample [Rep1 | Rep2 Measurements are done by columns, e.g. first the first repli-
cate of all samples, then the second replicate of all samples,
3 etc.
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Preparation

Parameter

Measurement start
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6. Single Assay

6.2 Measurements

At luminometer: Select NEXT and then PC-OPER.
In the PC software : Select a protocol (type Single Assay), click
<Run> and the program will go to the measurement menu.

Display of the run parameters. If you have defined the number of
replicates as variable, you may change this by clicking on the re-
spective button. A background value can also be set manually if
no background measurement is carried out. The value entered
here is subtracted from the raw data of each sample.

By opening / closing the sample drawer or by clicking on the Start
button.

The measurement values will be displayed in a table depending
on the definition in the protocol with the following columns (one
row for each sample):

[Sample] Sample name.

[Rep...] One column has been reserved for each repli-
cate. If the number of replicates was defined as
variable in the protocol, you may increase the
number of columns by clicking the appropriate
button (+).

[Average] This column contains the average values, calcu-
lated from the replicate results of that row.

[%SD/Avg] Standard deviation in percent, divided by average
value.

[Net] Average value minus background value.

[%SD/Net] Standard deviation in percent, divided by net
average value.

The measurement data trend of each single measurement with
data points can be displayed in a graph, either online or at the
end of the measurement, by clicking the graph button.
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7. Dual Assay FB12 Luminometer
7. Dual Assay
In the measurement mode Dual Assay two sample sequences A
and B are measured. Subsequently, a mathematical correlation is
established between both measurement sequences.
Typical application: Dual reporter gene assays.
71 Protocol
Select Dual Assay and press <Create>.
Figure 7-1: " Dual Assay Parameters - Dual Assay g|
Dialog box
[Dual Assay Pa' Senes & measurement and delay times Senes B measurement and delay times
rameters] Delay time: Measurement time: Drelay time: Measurement time: Gave bs |
[1.04 = [ = e = 1o =
Cancel
Page 1 4

[Series A measurement and delay time]

[Series B measurement and delay time]

Start meazurement by
(™ Start button or space bar or enter key

* Door close

[ First zample iz background

Cannments:

Mumber of replicates and samples

Mumber of replicates:

—

Measurement options

Transform:
T E—

Mumber of samples:

—

Measurement order:

A B AB. -

Advanced Options... |

Excel [TM] Dptichs...

[Delay time]

Delay for sequence A prior to each measurement; can be set only
if a measurement is started by closing the sample drawer.

[Measurement time] for each sample measurement of series A.

Enter parameters for series B in the same manner as for series A.
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FB12 Luminometer 7. Dual Assay

[Start Meas. by]
Select how to start the measurement:

[Start button]
By clicking on the Start button or by pressing the spacebar. No
delay time can be defined here!

[Door close]
By closing the sample drawer.

[Number of replicates and samples]
[Number of replicates]
[Number of samples]

[First sample is background]
Measurements of the first sample replicate are considered back-
ground measurements.

[Measurement options]

[Transform]
Select the calculation formula.

[Measurement order]

Selection of order: Either one sample of sequence B after each
one of sequence A, or all samples of sequence A in a row and
then all those of sequence B.

[ 1Berthold
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7. Dual Assay FB12 Luminometer

7.2 Measurements

Preparation At luminometer: Select NEXT and then PC-OPER.
In the PC software: Select a protocol (type Dual Assay), click
<Run> and the program will go to the measurement menu.

Parameter Display of measurement parameters series A and series B. The
measured background values are displayed in the [Background
A] and [Background B] text boxes, if the first sample of each se-
quence was defined as background in the protocol. A background
value can be entered manually. The value displayed here will be
subtracted from the raw data of each sample.

Measurement start By opening / closing the sample drawer or by clicking the Start but-

ton.

Results Display of measured values:

[Sample] Sample name.

[Net A] Net rate of series A = average value of the repli-
cates of the first sample of sequence A, minus
background.

[Net B] Net rate of series B

[A ...B] Calculation of the two net rates according to the

formula defined in the protocol
[%SD/Avg] Standard deviation in percent/average value.
[Rep ...A] Measurement value for replicates of series A.

[Average A] Average value from replicate results of series A of
the respective row.

[%SD/Avg] Standard deviation in percent/average value.
[Net] Average value minus background (series A).
[%SD/Net] Standard deviation in percent/average value.

The following columns contain the measured values for series B.
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FB12 Luminometer 8. Single Kinetics

8. Single Kinetics

The measurement type Single Kinetics is used to measure the
trend of the light emission over a specific period of time.

8.1 Protocol

Select Single Kinetics and push <Create>.

ST [1TCX: 2 Hl 5 Single Kinetics Parameters - Single Kinetics E|
Si IDI;I_OQ :).OX Tirne zettings
[ ’ng e lni Ics Delay time: Tatal duration: Sampling tirme:
arameters] |-|-':IS il |5-DS - ‘: I-IE'S—iI Save Az
Page 1 Mo, of data points: Interval time:
1 :I B0z Cancel
Mate: Interval tirme = Total duration / Mo. of data points [to nearest 0.23)
Start Hmer by
(" Stark buttan or space bar or enter key Mo, of replicates:
* Door close 1 ZI
Comment:

Advanced Options. . Excel [Th] Options...

[Time settings]
The following 5 parameters of this group box are mutually condi-
tional (with the exception of delay time):

[Delay time]
Delay before each measurement; can be set only if a measure-
ment is started by closing the sample drawer.

[Total duration]
Total sample measurement time, including the following times:

[Sampling time]
Measurement time per data point.
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8. Single Kinetics FB12 Luminometer

[No. of Data points]
Number of data points multiplied by the interval time shows the
total duration of the measurement.

[Interval time]
The interval time may be longer than the individual measurement
time of the data point.

[Start Meas. by]
Select how measurement is to be started on the measurement
menu.

[Start button]
By clicking the Start button or pressing the spacebar. No delay
time can be defined here!

[Door close]
By closing the sample drawer. Measurements with injectors can
only be started in this manner.

[Number of replicates]

<Advanced Options>
Click this button to open page 2 of the Single Kinetics Parame-
ters dialog box.

[Use luminometer as time basis]
Select the luminometer as time basis.
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8. Single Kinetics

8.2 Measurements

At luminometer: Select NEXT and then PC-OPER.
In the PC software: Select a protocol (type Single Kinetics), click
<Run> and the program will go to the measurement menu.

Display of measurement parameters. You may type a background
value into the [Background RLU/s] box. The value entered here
is subtracted from the raw data of each sample.

By opening/closing the sample drawer or by clicking the Start button.

The measurement values will be displayed in a table depending
on the definition in the protocol with the following columns (one
row for each sample):

[Time] Length of time the light emission is measured.
[Rep...] Measurement values for individual replicates.
[Average] Average value of replicates.

[YostdVv/Av] Standard deviation in percent, divided by average
value.

[Net] Net value (average value minus BG value)
[%SD/Net] Standard deviation in percent, divided by net
average value.

The measurement data trend of each single measurement can be
displayed in a graph, either online or at the end of the measure-
ment, by clicking the graph button. Further options for processing
the graph become visible when you enlarge the graph window.

[Group] Select which replicate curve(s) is to be displayed.
[Smoothing] Smoothes all displayed curves.
[Log scale] Logarithmic scaling.

[RLU-range] Select if scaling is to be applied automatically or
manually.
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9. Multiple Kinetics

FB12 Luminometer

9. Multiple Kinetics

Figure 9-1:
Dialog box

[Multiple Kinetics

Parameters]

Page 1

In the Multiple Kinetics mode, the trend of several samples is
measured in parallel over a longer period of time.

9.1 Protocol

Select Multiple Kinetics and push <Create>.

Multiple Kinetics Parameters - Multiple Kinetics

Time zettings

Drelay time: Total duration: S ampling hime:

= [10gs = [ = savess.
Mo, of data points: Interval time: c |
1 = [oos ﬁ

Mate: Interval time = Total duration / Mo. of data points [to nearest 0. 2z)

Replicates and zamples

Mumber of replicates: MHumber of samples:

— R —

Comments:
Excel [Th] Optiong. ..

[Time settings]
The following 5 parameters of this group box are mutually condi-
tional (with the exception of delay time):

[Delay time]
Delay before every measurement.

[Total duration]
Total sample measurement time, including the following times:

[Sampling time]
Measurement time per data point.
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Please note:
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Parameter
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Results

9. Multiple Kinetics

[No. of Data points]
Number of data points multiplied by the interval time shows the
total duration of the measurement.

[Interval time]
The interval time may be longer than the respective measurement
time of the data point.

[Number of replicates / samples]
The number of replicates or samples.

A measurement can only be started by closing the sample
drawer.

9.2 Measurements

At luminometer: Select NEXT and then PC-OPER.
In the PC software: Select a protocol (type Multiple Kinetics),
click <Run> and the program will go to the measurement menu.

Display of measurement parameters. You may type a background
value into the [Background RLU/s] box. The value entered here
is subtracted from the raw data of each sample.

By opening/closing the sample drawer or by clicking the Start button.
Measured values are displayed in a table:

[Time] Length of time, over which the light emission is
measured. The number of data points in [time] is
calculated by dividing the total measurement dura-
tion by the interval time.

[S1 Rep1] Measurement value of the first replicate of the first
sample.

[S1 Rep2] Measurement value of the second replicate of the first
sample.

[Average] Average value of replicates of the first sample.

[%SD/Avg] Standard deviation in percent, divided by average
value.

[Net] Net value (average value minus BG value).
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9. Multiple Kinetics FB12 Luminometer

[%SD/Net] Standard deviation in percent, divided by net aver-
age value.

[S2 Rep1] Measurement value of the first replicate of the second
sample.

[S2 Rep2] Measurement value of the second replicate of the
second sample.

[Average] Average value of replicates of the second sample.

[%SD/avg] Standard deviation in percent, divided by average
value.

[Net] Net value (average value minus BG value).

[%SD/Net] Standard deviation in percent, divided by net aver-
age value.

[S...Rep...] Further samples with replicates.
Graph The measurement data trend of each single measurement can be
fo, displayed in a graph, either online or at the end of the measure-

= ment, by clicking the graph button. Further options for processing
the graph become visible when you enlarge the graph window.
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10. Cut-off Assay

10. Cut-off Assay

Figure 10-1:
Dialog box
[Cut-oft
Parameters]

Page 1

A Cut-off protocol classifies samples into three categories. So-
called cut-off thresholds (high and low) are measured by defining
fixed parameters and measuring negative and positive controls.

10.1 Protocol

Select Cut-off ASSAY and press <Create>.

% u Cut-off Assay Parameters - Cut-off Assay

teasure and delay times

Drelay fime: teazurement time;

1.0z il 1.0z il Save Az
Start measurement by Bl

(" Start button or space o+ Door cloze
bar ar enter key

Analytes Megative/Pozitive contralz
Replicates: Samples: Megative replicates: Pozitive replicates:

R O T I EN== =

[ First zample iz background.
Cut-off calculations

Offzet Meq. Factar Pos. Factar
Low cut-off = |0 + [1.00 “ [Meg. Met] + 0,00 “ [Paoz. Met]
Offzet Meqg. Factor Pz, Factar
High cut-off = |0 + |0.00 * [Mea MNet) + [1.00 * [Pos. Met]
Comments:
Advanced Options... Eucel [Th] DOptions. ..
[Delay time]

Delay time before measurement; can be set only if measurement
is started by closing the sample drawer.

[Measur. time]
Measurement time for each sample measurement.

[Start Meas. by]
Select how to start the measurement on the measurement menu:
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10. Cut-off Assay FB12 Luminometer

[Start button]
By clicking the Start button or pressing the spacebar. No de-
lay time can be defined here!

[Door close]
By closing the sample drawer of the luminometer.

[Analytes] Define the number of replicates and samples.

[Negative/Positive controls]
Define the number of replicates of negative and positive controls.

[First sample is background]
Measurements of the first sample replicates are treated as back-
ground measurements.

[Cut-off calculations]
Definition of low and high threshold by the following parameters:

[Offset] Offset (RLU) value

+ [Neg. Factor] any constant

X [Neg. Net] net rate of negative control
+ [Pos. Factor] any constant

X [Pos. Net] net rate of positive control

<Advanced Options>
Click this button to open page 2 of the Cut-off Parameters dialog
box.

[Result text]
Designation for Cut-off results. The following designations are de-
faulted:

[Negative result text] NEG
[Positive result text] POS

[Equivocal result text] +/-

1 Berthold
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10. Cut-off Assay

10.2 Measurements

At luminometer: Select NEXT and then PC-OPER.
In the PC software: Select a protocol (type Cut-off), click <Run>
and the program will go to the measurement menu.

Display of measurement parameters. You may type a background
value into the [Background RLU/s] box. The value entered here
is subtracted from the raw data of each sample.

By opening/closing the sample drawer or by clicking the Start button.

Measured values are displayed in a table:

[Sample] Sample name.

[Rep...] A column is reserved for each replicate.

[Result] Result column. POS, NEG or +/- as result.
[Average] Average value from the replicates of one sample.
[%SD/Avg] Standard deviation in percent/average value
[Net] Average value minus background value.
[%SD/Net] Standard deviation in percent/net average value.
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11. External Printer with Additional Options FB12 Luminometer

11. External Printer with Additional Options

The FB12 luminometer can be upgraded by an external serial
printer to output the measured results directly to printer. To this
end, the interface has to be set to PRINTER in the instrument
software. In this mode, cut-off measurements can be carried out
in addition to extended raw data measurements and their results
can be output to printer.

The serial port is designed for the serial printer Seiko Instruments
TM DPU-414, which you can order directly from Berthold Detec-
tions Systems.

1.1 Physical Installation of the Printer

Q The Seiko TM DPU-414 Thermal Printer is supplied with a
power supply (7.5V) and an interface cable (9 pin data cable,
male-female)

O Plug the appropriate plug module into the power supply. The
power pack adjusts to the supply voltage of 220V or 110V.

O The power supply should be properly plugged into the wall
outlet, while the pin plug is plugged into the connection at the
back side of the printer.

Q The power supply of the printer and the luminometer can be
discriminated by the standard device plug (5,5mm) and the
CINCH plug (3.5mmm), respectively.

a Connect the enclosed interface cable to the serial ports. The
female end should be plugged in to the back of the FB12,
while the male end should be plugged in to the pack of the
printer.
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11. External Printer with Additional Options

11.2 Printer Setup
From the main menu on the FB12, press the NEXT button and go
into SYSTEM.
FB12 LUMINOMETER V2.2
MEASURE MEAS.SET. NEXT
v
PC-OPER SYSTEM NEXT
v
SYSTEM
CONFIG CHECK NEXT
v
RS232 FOR PC / PRINTER
SCROLL MAIN NEXT

1 Press SCROLL to adjust the instrument from PC configuration
to the printer configuration. Confirm your entry with <ENTER>.

(d Push MAIN to return to the main menu.

11.3

Cut-Off Protocol

Provided the interface is set to PRINTER, you can choose either
cut-off protocol or extended raw data protocol by pushing
MEAS.SET. on the main menu (see chapter 11.5) and define the

respective protocols:

FB12 LUMINOMETER V3.0

MEASURE MEAS.SET. NEXT
v

PROTOCOL RD/ CUT-OFF

SCROLL MAIN NEXT

[ 1Berthold
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11. External Printer with Additional Options

U Push SCROLL to select the cut-off protocol.

FB12 Luminometer

CRPERAICR  cccococoocoocoocoocoocooooooao
SCROLL CURSOR NEXT
v
TESTNAME . .. .. ittt
SCROLL CURSOR NEXT

Enter a user name and a test name and then define the cut-off
factor, the number of negative standard replicates, the sample
replicates, the delay time and the measuring time:

CUT-OFF-FAKTOR: X . XXX
SCROLL CURSOR NEXT
v
NEG. STAND. REPL.: 2
SCROLL CURSOR NEXT
v
SAMPLE REPL. : 1
SCROLL CURSOR NEXT
v
DELAY TIME: 2.0 s
SCROLL CURSOR NEXT
v
MEASURING TIME: 10.0 s
SCROLL CURSOR NEXT
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FB12 Luminometer 11. External Printer with Additional Options

1.4 Cut-off Measurement

The CUT-OFF protocol will allow replicates to be measured and
classified as positive or negative samples. This is done by calcu-
lating a Cut-off threshold. Based on the average of the negative
standard replicates and the Cut-off factor this threshold is calcu-
lated as follows:

Ned-STD.-Replicates —Average x Cutoff-Factor = Cutoff-threshold

The RLU value of the negative standard replicates are measured
at the beginning of the measurement sequence. From there the
Cutoff-threshold is calculated.

If the interface has been set to PRINTER and you have selected
the cut-off protocol (after you have pushed MEAS.SET.), you can
run a cut-off measurement by selecting MEASURE on the main
menu:

O Select menu MEASURE.

Q The Cut-off measurement menu starts.

Place tubes for negative standard replicate 1 and close sam-
ple drawer to start the measurement sequence.

A Open sample drawer at the end of the measurement and re-
move sample tube.

Q Proceed as instructed on the display: insert sample tube for
2 negative standard replicate and close sample drawer.

O Average value and standard deviation are calculated and
printed out after completion of all standard measurements.
You are then prompted to insert the first sample replicate.

O Close sample drawer. The measured values as well as the re-
sult of the sample classification are printed out at the end of
the measurement.

a Open sample drawer and replace sample tube.

Following this protocol you can measure as many samples as
you choose.
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11. External Printer with Additional Options FB12 Luminometer

Printout to external printer

Example: Date: XX XX XXXX  XX:XX

Name:

CUT OFF Assay:
Neg. STD Repl =3 Sample replicate = 1
Delay-Time = 2.0s Meas.Time = 5.0s

Cut-off factor = 2.000

Neg. STD Repl. Result
1 415 RLU/s
2 435 RLU/s
3 410 RLU/s

Neg. Standard Avg = 420 RLU/s

%VC = 2.6%

Cut-Off-Value 840 RLU/s

Then the samples to be classified may be measured. Based on
the calculated Cut-Off value of e.g. 840 RLU/s, any measurement
results below 840 RLU/s will be denoted as NEGATIVE, while any
value above 840 RLU/s will be denoted POSITIVE.

11.5 Extended Raw Data Protocol

With the interface set to PRINTER, select the raw data protocol
on the main menu as follows:

FB12 LUMINOMETER V3.0

MEASURE MEAS.SET. NEXT
v

PROTOKOLL RD/ CUT-OFF

SCROLL MAIN NEXT

Push SCROLL to select the raw data protocol. In this case, the
raw data protocol is extended: you may enter a user name and a
test name in addition.
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FB12 Luminometer 11. External Printer with Additional Options

11.6 Raw Data Measurement

A raw data measurement is started just like a cut-off measure-
ment by selecting the MEASURE menu.

The current measured value is printed out without any further
modification or calculation. In addition, the measurement parame-
ters you have defined, the date as well as the entered user and
test name will be documented.
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12. Maintenance FB12 Luminometer

12. Maintenance

The FB12 luminometer is practically maintenance-free. It only has
to be protected from dirt and may have to be cleaned.

The surface of the instrument is protected by a robust and wash-
able finish. Should it become dirty or dusty, we recommend wip-
ing it with a damp cloth. If necessary a mild detergent (not an
abrasive!) can be used.

The sample drawer and especially the measurement window also
have to be kept clean and should be wiped off with a damp cloth
if dirty.

Please keep in mind that the screw on top of the instrument must

always be firmly closed. The PMT may get damaged by incidence
of light.

A No fluid should ever enter the instrument! If this should hap-
pen, disconnect the instrument immediately and notify a ser-
vice representative!
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13. Technical Data

13. Technical Data

Sample format

e Sample tubes up to 12 mm diameter (12 mm = standard) and
up to 75 mm length, with or without cap

e 35 mm diameter culture dishes
e Scintillation vials up to 20 ml
e Microfuge tubes

Detector Photomultiplier tube with bialkali cathode, effective spectral
range 300-600 nm (extended range on request), operated in
photon counting mode

Sensitivity Less than 1,000 molecules firefly luciferase

1 amol ATP in a HS assay

Dynamic range

6 decades

Hardware

Micro-controller controlling all instrument functions

Microprocessor
software

Operation via 3 softkeys and 1 <ENTER> button

e Delay and measurement time settings in increments of 0.1 s
e Data output in RLU/sec

Additional data evaluation modes (external printer required)

e Extended raw data protocol,

e Cut-Off protocol

Measurement time

0,2-999s

Interfaces RS 232 or USB interface for PC connection
Printer External printer (option)

Dimensions W 220 mm, D 170 mm, H 220 mm

Weight approx. 2.5 kg

Power supply

DC 12V, 0.6 A, supplied through mains adapter (included)

Temperature range

Storage 0° -40°C
Operation 10° — 35°C

Humidity

10% - 80%
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13. Technical Data FB12 Luminometer

PC software MS Windows application for measurement and evaluation

Platform/ Required Windows® compatible PC, Pentium like processor, RS232 or
Hardware USB port.

Operating System | Windows® 2000, XP
Additional Software |Microsoft® EXCEL 2000, XP (optional)

Accessories

Order number Description
18100010 Reflector type RFB201.3
18120010 Power supply unit (12V, min. 0.8 A, input voltage 100-240V )
18200250 Serial data cable
18200260 USB cable
13200500 5 ml tubes, 12x75 mm, 500 each
15300100 External thermo printer Seiko DPU 414 with data cable, power
supply (12V, min. 0,8 A, input voltage 100-240V)
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14. Preparing FB12 for Transport

14. Preparing FB12 for Transport

Original packaging
of FB12 :
Add the accessory-
box finally

If it should become necessary that FB12 has to be serviced please
observe the following instructions for shipping it to your local distribu-
tor or Berthold Detection Systems.

1. Turn luminometer off and disconnect power supply.

2. Remove the reflector.

3. For safe shipment put the luminometer and the accessory box
into the original cardboard box and seal it. If the original box is not
available please contact [service@berthold-ds.com| We will send
a box back to you.

Space holder

Foam parts

4. Before return please contact your local distributor or Berthold De-
tection systems for shipping instructions.
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15. Index

15. Index

ANAIYIES ... 36
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16. Decontamination Form

Any laboratory instrument used for clinical or research analysis maybe considered a
biohazard and requires decontamination prior to handling. Universal precautions are
suggested wherever applicable.

Before shipping any instrument back to Berthold Detection Systems the luminome-
ters have to be cleaned in the following way:

1. Wash the housing with a moist cloth, if necessary use a mild detergent or disin-
fectant. Do not use any scouring agents!

2.  Open the access door, remove and clean the reflector, then clean the meas-
urement chamber with the measurement window carefully. Use e.g. cotton
buds for hard to access locations.

Berthold Detection Systems only accepts instruments for repair together with a filled
out decontamination form. Please copy this page and fax it to us before you send off
the package. Thank you.

Instrument Type:

Serial Number:

[] | confirm that the specified instrument was decontaminated
according to the above described decontamination procedure

[] | confirm that the above specified instrument had no contact to
any hazardous material.

Company

Contact Person

Position

Telephone

Date: Signature:

Please copy and fax to:
Berthold Detection Systems, Bleichstr. 56-68, 75173 Pforzheim,
Tel.:+49-(0)7231-9206-0, Fax -50

[ 1Berthold
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